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.  
Edition Notices

This edition notice provides important information regarding the documentation for version 
5.1 of the CoolSign Content Creator product. Later releases are intended to be backwards-
compatible, but may introduce new functionality not addressed in this content. Likewise, 
other product documentation may describe functionality not addressed here that will 
become available in later releases. Please consult with Haivision Systems, Inc. or its autho-
rized representatives to ensure compatibility.

Copyright

© 2006-2015 Haivision. All rights reserved.

Title: CoolSign Content Creator User’s Guide  
Document Number: HVS-ID-UG-CS-CC 
Version Number: 5.1

This publication and the product it describes contain proprietary and confidential informa-
tion. No part of this document may be copied, photocopied, reproduced, translated or 
reduced to any electronic or machine-readable format without prior written permission of 
Haivision. If this document is distributed with software that includes an end-user agree-
ment, this document and the software described in it, are furnished under license and may 
be used or copied only in accordance with the terms of that license. Except as permitted by 
any such license, no part of this guide may be reproduced, stored in a retrieval system, or 
transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, 
without the prior written permission of Haivision Systems Inc. Please note that the content 
in this guide is protected under copyright law even if it is not distributed with software that 
includes an end-user license agreement.

IMPORTANT
Content Creator is designed to access/play content which may have copyright 
restrictions. Acquiring licensing and re-distribution rights to restricted content shall be 
undertaken by the purchaser and not by Haivision. Please be sure to obtain any 
permission required from the copyright owner.

Licenses

This product is licensed under the MPEG-4 visual patent portfolio license for the personal 
and non-commercial use of a consumer for (i) encoding video in compliance with the 
MPEG-4 visual standard (“MPEG-4 video”) and/or (ii) decoding MPEG-4 video that was 
encoded by a consumer engaged in a personal and non-commercial activity and/or was 
obtained from a video provider licensed by MPEG LA to provide MPEG-4 video. No 
license is granted or shall be implied for any other use. Additional information including 
that relating to promotional, internal, and commercial uses and licensing may be obtained 
from MPEG LA, LLC. See http://www.mpegla.com.
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.  
Patents

CoolSign is covered by U.S. Patent Number 7,136,906 “System for Electronically Distrib-
uting, Displaying and Controlling the Play Scheduling of Advertising and Other Commu-
nicative Media” and Patent Number 7,228,341 “Method and System for Electronically 
Distributing, Displaying and Controlling Advertising and Other Communicative Media.” 
CoolSign may also be covered by one or more pending United States patent applications.

Trademarks

The Havision logo, Havision, Furnace, Hai1000, Makito, HaiPLAY, Piranha, InStream, 
Stingray, Torpedo, Kraken, Viper, Madra, and KulaByte are trademarks of Haivision. 
CoolSign is a registered trademark licensed to Haivision Systems, Inc. All other brand or 
product names identified in this document are trademarks or registered trademarks of their 
respective companies or organizations. 

Adobe, Flash Media Server, Flash, Flash Lite and Shockwave are trademarks of Adobe 
Systems Incorporated in the United States, other countries, or both. Apple, iPhone, iPad, 
iPod Touch are trademarks of Apple Incorporated in the United States, other countries, or 
both. 

All other brand or product names identified in this document are trademarks or registered 
trademarks of their respective companies or organizations. 

Disclaimer

The information contained in this document is subject to change without notice. Haivision 
assumes no responsibility for any damages arising from the use of this document, including 
but not limited to, lost revenue, lost data, claims by third parties, or other damages.

If you have comments or suggestions, please contact:

Haivision 
ATTN: Information Development 
4445 Garand 
Montréal, Québec, H4R 2H9 Canada

Telephone: 1-514-334-5445

Email: info@haivision.com

While every effort has been made to provide accurate and timely information regarding this 
product and its use, Haivision Systems Inc. shall not be liable for errors or omissions 
contained herein or for incidental or consequential damages in connection with the 
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.  
furnishing, performance, or use of this material. The latest information available can be 
acquired from our web portal at:  http://www.haivision.com/download-center/ 

NOTE
A login is required to access the Haivision Download-Center.
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About This Book

Welcome to the CoolSign™ 5.1 User’s Guide. This document describes how to configure 
and manage the Havision Content Creator software.

Topics Discussed

About Haivision™ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Audience  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Reliability of Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Obtaining Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Service Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Document Conventions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9

About Haivision™

Haivision is a global leader in delivering advanced video networking, digital signage, and 
IP video distribution solutions. Haivision offers complete end-to-end technology for video, 
graphics, and metadata to help customers build, manage and distribute their media content 
to users throughout an organization or across the Internet. Haivision has specific expertise 
in the enterprise, education, medical/healthcare, and federal/military markets. 

Haivision acquired the assets of CS Software Holdings, LLC, including the CoolSign 
product technology, in November, 2010. This acquisition brought together Haivision's IP 
video streaming capabilities and CoolSign's feature-rich signage solution, with its sophis-
ticated technology to control, schedule, distribute, display, and monitor digital media.

Haivision is based in Montreal and Chicago, with technical centers in Beaverton, Oregon; 
Austin, Texas; and Hamburg, Germany. 

Audience

This user’s guide is focused towards an end-user, such as a content creator or network 
system administrator, who has a basic knowledge of telecommunications equipment, and 
IP/LAN networking concepts and terminology. 

Related Topics

Reliability of Information on page 9
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. About This Book 
Reliability of Information
Reliability of Information

The information contained in this user’s guide has been carefully checked and is believed 
to be entirely reliable. However, as Haivision improves the reliability, function, and design 
of its products, the possibility exists that this user’s guide may not remain current.

If you require updated information, or any other Havision product information, contact:

Haivision 
4445 Garand 
Montréal, Québec, H4R 2H9 Canada

Telephone: 1-514-334-5445 
Email: info@haivision.com

Or visit our website at: https://www.haivision.com.

Related Topics

Obtaining Documentation on page 9

Obtaining Documentation

You can download product documentation through the Havision Download Center at 
http://www.haivision.com/download-center/.

NOTE
A login is required to access the Haivision Download Center.

Related Topics

Service Support on page 9

Service Support

For more information regarding service programs, training courses, or for assistance with 
your support requirements; contact Havision Technical Support using our Support Portal 
at: https://www.haivision.com/support/.

Related Topics

Reliability of Information on page 9

Document Conventions

The following conventions are used throughout this document.
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. About This Book 
Document Conventions
Typographic Conventions and Elements

Italics Used for the introduction of new terminology or for words being 
used in a different context, and for placeholder or variable text.

bold Used for strong emphasis.

Monospaced Used for code examples, command names, options, responses, 
error messages, and to indicate text that you enter.

Button Indicates a button or some object that you click.

> In addition to a math symbol, it is used to indicate a submenu. For 
instance, File > New where you would select the New option from 
the File menu.

... Indicates that text is being omitted for brevity.

Admonition Elements

The following admonition elements are used to advise and counsel that special actions 
should be taken.

TIP
Indicates highlights, suggestions, or helpful hints. 

NOTE
Indicates a note containing special instructions or information that 
may apply only in special cases.
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. About This Book 
Document Conventions
IMPORTANT
Indicates an emphasized note. It provides information that you 
should be particularly aware of in order to complete a task and 
that should not be disregarded. IMPORTANT is typically used to 
prevent loss of data.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 
may result in damage to data or equipment, or minor to moderate 
injury. It may also be used to alert against unsafe practices.
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Getting Started with Content Creator

The CoolSign® Content Creator is a full-featured application for creating content for a  
Digital Media Network. It is specially designed to aid in the design and creation of content 
that uses dynamic data, but can be used as a general-purpose content animation tool as well.

Content is perhaps the most important element within a CoolSign Digital Media Network. 
Without content, your screens would be dark. While CoolSign does not include tools for 
the authoring of digital assets like bitmaps and video, it supports most of the standard 
digital file formats used by today’s content creation applications including H.264, 
Windows Media 9, Flash, PhotoShop bitmaps, and PowerPoint slides.

IMPORTANT
The Content Creator tool is not compatible with remote desktop software.

Topics Discussed

CoolSign Content Creator Requirements  . . . . . . . . . . . . . . . . . . . .  13
Supported Media Formats  . . . . . . . . . . . . . . . . . . . . . . . . . .  13
Defining Project Settings . . . . . . . . . . . . . . . . . . . . . . . . . . .  13

Project Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
General Project Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Playback Project Settings  . . . . . . . . . . . . . . . . . . . . . . . . . .  16
Dynamic Data Project Settings  . . . . . . . . . . . . . . . . . . . . . . .  16
Advanced Project Settings . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Understanding the Content Creator Workspace . . . . . . . . . . . . . . . . .  18
Customizing Your Workspace . . . . . . . . . . . . . . . . . . . . . . . .  20

Using the Media Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Using the Media Window Selection Tool  . . . . . . . . . . . . . . . . .  21
Using the Media Window Zoom Control . . . . . . . . . . . . . . . . . .  22
Setting Display Options in the Media Window  . . . . . . . . . . . . . .  23
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. Getting Started with Content Creator 
CoolSign Content Creator Requirements
CoolSign Content Creator Requirements

Supported Media Formats

Audio Image Video

MP3 bmp
gif

jpeg
png
psd

WMV
Flash

MPEG-1
MPEG-4

AVI
M2V
MOV

MP4 (H.264 only)
H.264

Defining Project Settings

When you launch CoolSign Content Creator, the Welcome window automatically appears:

Within Content Creator, all of your work takes place within the context of a project. In this 
section, you’ll define settings for your project.

• To open a new project, click Create new project.
• To open an existing project, click Open existing project and select the project folder. 

Then choose the menu item Project > Project Settings.
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. Getting Started with Content Creator 
Project Settings
Project Settings

The Project Settings allow you to specify how the content is displayed, transitioned, 
triggered — even how missing data is handled. 

IMPORTANT
You can only specify the Project Type when you create a new project. Unlike other 
project settings, the Project Type can not be revised after the project has been 
created.

The Project Type can be either: 

STANDARD — (default) used for developing most individual pieces of content; anything 
from simple pictures and videos to more complex content that displays dynamic data.

TEMPLATE — used when creating a model that will be used to create new instances of 
content with similar layouts but that might differ in the actual text and/or graphic elements 
from the model. 
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. Getting Started with Content Creator 
Project Settings
General Project Settings

In the General tab, you define the project type1, name, duration, display type, orientation, 
and resolution.

Table 1: Project Settings: General Tab 

Fields Purpose

Project 
Type

Select the appropriate listing for the 
type of content you are creating:
• Standard
• Template

Name The name of your content as it 
appears in CoolSign Network 
Manager (CNM).

Duration Length that your content plays. The 
duration is limited by the length of your 
imported asset.

Display 
Type

If you select a preset display type, the 
orientation and resolution fields are 
automatically filled in for you. Your 
content can still be displayed on other 
display devices but looks best on this 
display type.

Orientation Landscape or portrait, depending on 
how you’ll be orienting the target 
display device.

Resolution The horizontal and vertical resolution 
of your content in pixels.

1. Project Type can only be specified when a new project is being created and not by opening the Project 
Settings for an existing project.
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. Getting Started with Content Creator 
Project Settings
Playback Project Settings

In the Playback tab, you define the effect that you’ll use to transition into this content, along 
with settings that affect how content is resized during playback.

Table 2: Project Settings: Playback Tab 

Fields Purpose

Transition Sets the effect that is used to transition 
from the previous played content into 
this content. You can also define the 
duration of the transition effect in 
seconds.

Scale 
Content to 
Fit

Scales content to fit the resolution of 
the player the content is scheduled on. 
If the aspect ratio of the player does 
not match the content’s aspect ratio, 
the content is stretched non-linearly to 
fill the player (unless you also check 
Preserve Aspect Ratio).

Preserve 
Aspect 
Ratio

Forces scaled content to preserve its 
original aspect ratio when played on 
players with different resolutions and 
aspect ratios than that of the content. 
The behavior of this checkbox is 
further defined by the following radio 
buttons:.

• Crop edges of content — When 
scaling to fit, the content is scaled 
linearly until the smaller of the 
content’s width or height matches 
the smaller of the player’s width or 
height. This might result in pixels 
being cropped off the edge of the 
player.

• Letterbox content — When scaling 
to fit, the content is scaled linearly 
until the larger of the content’s width 
or height fits into the player’s width 
or height. The empty area that 
remains is black.

Dynamic Data Project Settings

In the Dynamic Data tab, you define what to do if the data table is empty.
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. Getting Started with Content Creator 
Project Settings
Data tables are mini-databases with a structure that is flexible enough to enable you store 
anything from a single piece of information to a complex table with dozens of fields and 
hundreds of records of data. Refer to the CoolSign Network Mangager User’s Guide for 
more details.

Continue playback with no data — Play the content anyway, even if no data is present.

Abort playback and silently log an error — Don’t play the content, but do not log a 
visible error.

Abort playback and set region status to Content Error — Don’t play the content and 
issue a region status error.

When you’re done, click the Advanced tab.

Advanced Project Settings

In the Advanced tab, you can define additional settings that affect your content.
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. Getting Started with Content Creator 
Understanding the Content Creator Workspace
Content scheduled as triggered — Check this box if you are creating dynamic content 
that you intend to schedule as triggered with CNM. This setting modifies the content scripts 
to work correctly when triggered.

Content used as Overlay Content — Check this box if you are creating content that 
you intend to use in the Overlay Content channel of a player. Overlay content is played on 
top of the currently tuned channel’s content. (Deprecated; this checkbox is provided to 
support legacy content. See the discussion of “Layering Regions” in the “Configuring 
Players” section of the CoolSign Network Mangager User’s Guide.)

Return to content — If you are creating content that you intend to be interactive, you can 
enter the name of the content that should be played immediately after this content is played.

When you’re done, click OK to save your project settings and open the Content Creator 
workspace.

Understanding the Content Creator Workspace

The Content Creator workspace enables you to define, layout, and preview your CoolSign 
content as you work.
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 18



. Getting Started with Content Creator 
Understanding the Content Creator Workspace
The workspace contains the following components:

Menu bar — Contains menus for performing tasks. Many of the menu functions can also 
be accomplished from the keyboard or by using other Graphical User Interface (GUI) 
controls. For example, you can start content playback by choosing PLAYBACK > PLAY, 
entering Ctrl-P, or clicking the Play arrow button in the Timeline window.

Media window — Displays the current content as well as a toolbar for manipulating and 
creating assets. You can think of the media window as the stage on which all of your actions 
take place: drawing shapes, adding text, resizing content, positioning imported assets, 
laying out data fields, and viewing content playback. See “Using the Media Window” on 
page 21.

Timeline window — Contains buttons for previewing the playback of your content and 
lists all of the layers in your project. See “Using the Timeline Window” on page 46.
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. Getting Started with Content Creator 
Understanding the Content Creator Workspace
Properties window — Displays properties for the asset that is currently selected in the 
timeline window or media window.

Data Tables window — Enables you to create and manage the dynamic data table that is 
used to provide data to your content. See “Using Templates” on page 52.

Customizing Your Workspace

The Content Creator attempts to size and position the windows within your workspace to 
best fit the orientation of the content and the size of the screen. If necessary, you can easily 
resize, hide, dock, and undock the windows and save the changes to your own custom 
layout.

To save your current workspace:

1. Choose WINDOW > SAVE CURRENT LAYOUT.

2. Enter a name for your new layout, and click OK.

To load an existing workspace:

1. Choose WINDOW > LOAD WINDOW LAYOUT.

2. Select the desired layout from the sub-menu.
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. Getting Started with Content Creator 
Using the Media Window
Using the Media Window

This section describes how to use the Toolbox elements located at the top-left of the Media 
Window. Toolbox elements are shown below:

Selection Tool

Rectangle Shape Tool

Ellipse Shape Tool

Text Tool

Scroll Tool

Data Panel Tool

Data Field Tool

Subsequent sections explain how to perform these tasks in the media window:

• Importing assets (see “Importing Assets into Content Creator” on page 24)
• Drawing shapes (see “Creating Shapes” on page 35)
• Adding text (see “Creating Text Fields” on page 37)
• Scrolling your content (see “Scrolling Your Content” on page 41)

Using the Media Window Selection Tool 

The toolbar along the left side of the media window (refer to the previous graphic) provides 
various tools for adding new assets or manipulating the assets in your content. You can use 
the Selection Tool to select, reposition, resize, and rotate assets in the media window.

To select an asset in the media window:

1. Select the Selection Tool.
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. Getting Started with Content Creator 
Using the Media Window
2. Click the asset in the media window or in the timeline.

To reposition an asset in the media window:

1. Select the Selection Tool.

2. Click and drag the asset in the media window (or in the timeline) to the position you 
want to set.

To resize an asset in the media window:

1. Select the Selection Tool.

2. Click the asset (in the media window or in the timeline) to select it.

3. Click and drag on one of the selection box handles. Hold SHIFT to constrain both 
dimensions.

To rotate an asset in the media window:

1. Select the Selection Tool.

2. Click the asset (in the media window or in the timeline) to select it.

3. While holding down the CTRL key, click and drag on one of the selection box 
handles.

Using the Media Window Zoom Control

If your content does not fit within the media window, you can zoom in or out to make it fit.

To resize your content within the media window:

• Select a zoom percentage from the ZOOM pull-down menu. You can also click in the 
Zoom box and enter a custom zoom level.
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. Getting Started with Content Creator 
Using the Media Window
Setting Display Options in the Media Window

At the top of the media window, you can pull down the OPTIONS menu to set the following 
display options:

Show Selection Handles — When this option is selected (checked), some elements 
might display selection handles or other GUI elements to help you manipulate them inter-
actively in the media window. You can hide the elements if you want to view the content 
as it appears when played using CoolSign Network Manager. (These elements are automat-
ically hidden for you during content playback.) To hide GUI elements, uncheck Show 
Selection Handles.

Show Media Info — When this option is selected (checked), the media window displays 
the filename, resolution, and frame rate for each imported bitmap, video, or flash asset.

Show FPS — When this option is selected (checked), displays system performance 
information in the top-left corner of the media window. Information includes the frame rate 
per second as well as CPU and memory usage.

Toggle Full Screen — When this option is selected (checked), displays the media 
window in full-screen mode, hiding all other functions of the Content Creator. To exit full 
screen mode, press Alt+Tab.

Dump Trace — When this option is selected, saves and stores a diagnostic log of recent 
activity at:

C:\Users\user_name\AppData\Local\CoolSign\Content Creator\Logs\
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Content Creation Basics
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Importing Assets into Content Creator

This section explains how to import static images, digital video, and Flash files into your 
project.

All asset types have the following properties:

Name — By default, the asset’s name matches that of the imported file. You can change 
the asset name to a more appropriate name if desired.

Size — The width and height of the asset, respectively. You can click in the Size boxes to 
resize an imported asset.

File Name — The full path to the file used for the asset.

File Size — The disk size of the imported file.

You can also define an asset’s layout properties:
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Scale Mode— You can select Fill or Letterbox to change the appearance of the asset when 
its size differs from the size of the media that it contains.

Anchor Point — If the scale mode is not Fill, you can click one of the nine boxes to control 
whether the media remains centered or floats to a particular side of the bounding box.

Other properties are specific to the type of asset. For details, see the following discussions:

• Importing bitmaps (see “Importing Bitmaps into your Project” on page 25).
• Importing video (see “Importing Video Into Your Project” on page 31).
• Importing Flash files (see “Importing Flash Into Your Project” on page 33).

Importing Bitmaps into your Project

Content Creator supports 32-bit images in the following formats: Adobe Photoshop (*.psd), 
JPEG (*.jpg), Windows Bitmap (*.bmp), Portable Network Graphics (*.png), and Graphics 
Interchange Format (*.gif). If the image contains an alpha channel, the black areas of the 
alpha channel are transparent.

To import a bitmap into your project:

1. Choose ASSETS > IMPORT FILE...

2. In the dialog box, select the asset file to import.

To edit bitmap properties:

1. Select the bitmap in the media window or in the timeline to display the Bitmap 
properties window.
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2. In addition to the properties that are common to all assets (name, size, file name, and 
file size), bitmap assets have the following property:
Image Size — The original unscaled size of the imported file.

3. You can set properties to add a soft drop shadow to bitmap assets:

Show drop shadow — When checked, show a drop shadow on the selected asset.

Blur — How soft the drop shadow should be.
Opacity — The opacity of the drop shadow effect.
Color — The color of the drop shadow.
Offset — The offset in pixels that the drop shadow should be positioned.

4. If you are building interactive content, you can specify the content to play when this 
shape is clicked.
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Hit Link The name of the content to play when this shape is clicked.

To specify multiple pieces of content, separate the names with semicolons. To specify 
the region in which to play the content, include the @ sign. In this example, the content 
named MyVid1 plays in the region containing the object that was just clicked, and 
MyVid2 is queued to play after it. Meanwhile, MyVid3 immediately begins playing in 
AnotherRegion.

IMPORTANT
The requested content must be scheduled within the channel. It can be disabled, so 
that it only plays if someone clicks a Hit Link, but it does need to be in the channel.

Creating Interactive Content

In the following example, Hit Link content has two link areas (Link to Item 1 and Link to 
Item 2) that when clicked, triggers the appropriate content item to play. 
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All interactive content using the Hit Link feature needs to be scheduled in the channel using 
the CNM Channel Manager. In the previous example, the Simple Menu content also has to 
be scheduled.

Once scheduled, the Hit Link content plays. In this case, Item 1 for 15 seconds and Item 2 
for 5 seconds.
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The Hit Link content must be disabled; otherwise, it will play continuously. By disabling, 
the Hit Link content only plays when clicked.
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The home content plays as scheduled and items 1 and 2 play only when clicked.
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Importing Layered Adobe Photoshop Files Into Your Project

When you import a layered Photoshop file into your project, the Content Creator creates 
bitmap assets for each layer. This allows you to manipulate individual layers in the Content 
Creator timeline panel.

IMPORTANT
The Photoshop file must be a 16-bit or 32-bit RGB-type file. Layer effects and 
adjustment layers are not supported. Also, grouping layers into folders in the 
Photoshop Layer window is not supported.

To import a layered Photoshop file into your project:

• Choose ASSETS > IMPORT PHOTOSHOP WITH LAYERS...

Importing Video Into Your Project

Content Creator supports the following digital video formats: 

• MPEG-4 (*.mpg or *.mp4)
• MPEG-1 (*.mpg)
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• AVI (*.avi)
• Windows Media 9 (*.wmv)
• H.264 (*.mov files created using the H.264 compressor/codec).

To import a video into your project:

1. Choose ASSETS > IMPORT FILE...

2. In the dialog box, select the asset file to import.

To edit video properties:

1. Select the video asset in the media window or timeline to display the Video properties 
window:

2. In addition to the properties that are common to all assets (page 24), video assets have 
the following properties:
Duration — The duration of the imported movie.
Original Size — The original unscaled size of the imported movie.
Orientation — The orientation at which the movie was authored. You can use the 
pull-down menu to change the orientation.
Loop video playback — When checked, forces the video to loop continuously while 
the content is playing. This is only useful if the duration in timeline is greater than the 
length of the video asset.
Hit Link — If you are building interactive content, you can specify the name of the 
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content to play when this video is clicked. To specify multiple pieces of content, sep-
arate the names with semicolons. To specify the region in which to play the content, 
include the @ sign. For an example of this usage, see the description of Hit Link on 
page 25.“Hit Link” on page 27
The requested content must be scheduled within the channel. It can be disabled, so that 
it only plays if someone clicks a Hit Link, but it does need to be in the channel.

Importing Flash Into Your Project

You can import Shockwave Flash (SWF) files exported from Adobe Flash or Adobe Live-
Motion. ActionScript-driven Flash is supported if you enable the Timeless option 
(page 35).

To import a Flash file into your project:

1. Choose ASSETS > IMPORT FILE...

2. In the dialog box, select the asset file to import.

TIP
If you set the background color of an SWF movie to #0000FF (R:0 G:0 B:255), it is treated 
as transparent with CoolSign.
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To edit flash properties:

1. Select the flash asset in the media window or timeline window to display the Flash 
Properties window:

Verify that the name of the Flash content does not contain any of the special characters 
that are disallowed in file names (/ \ : etc.).

2. In addition to the properties that are common to all assets (page 24), Flash assets have 
the following properties:
Duration — The duration of the imported SWF.
Loop Playback — When checked, forces the SWF to loop continuously while the con-
tent is playing.
Show Transparency — When checked, whatever areas of the Flash file were de-
signed to be transparent are rendered with a transparent background. Checking this box 
has no visible effect if the Flash file contains no transparency.
Timeless — When checked, ignores the Flash asset’s timeline.
Use Legacy Flash Player — When checked, provides backward compatibility for 
SWF files earlier than Flash 4.
Hit Link — If you are building interactive content, you can specify the name of the 
content to play when this video is clicked. To specify multiple pieces of content, sep-
arate the names with semicolons. To specify the region in which to play the content, 
include the @ sign. For an example of this usage, see the description of Hit Link on 
page 25.
Alternatively, you can set up the hit link via an ActionScript call. For details, see the 
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tech note “Accessing CoolSign Data from Flash“, available from Haivision Systems 
Inc. EEK! Tech Note reference.

IMPORTANT
The requested content must be scheduled within the channel. It can be disabled, so 
that it only plays if someone clicks a Hit Link, but it does need to be in the channel.

Creating Shapes

The Content Creator provides a rectangle shape tool and ellipse shape tool for creating 
basic shapes in your content. The shapes can be set with a fill color, a stroke color, and a 
stroke width.

To create a rectangle shape tool:

1. Select the rectangle shape tool.

2. Click and drag in the media window to create the rectangle. Hold down SHIFT to 
constrain the shape to a square.

To create an ellipse shape tool:

1. Select the ellipse shape tool.

2. Click and drag in the media window to create the ellipse. Hold down SHIFT to 
constrain the shape to a circle.
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To edit shape properties:

• Select the shape in the media window or timeline to display the Shape Properties 
window:

Name — The name of the shape as it appears in the timeline and script.
Type — The type of shape.
Size — The width and height of the shape, respectively.
Fill Color — The color that is used to fill the interior of the shape.
Stroke Color — The color that is used to stroke the outline of the shape if the Stroke 
Width is greater than zero.
Stroke Width — Sets the width of the line that is used to stroke the outline of the 
shape. Setting the stroke width to zero removes the stroke.
Hit Link — If you are building interactive content, you can specify the name of the 
content to play when this video is clicked. To specify multiple pieces of content, sep-
arate the names with semicolons. To specify the region in which to play the content, 
include the @ sign. For an example of this usage, see “Creating Interactive Content” 
on page 27.

IMPORTANT
The requested content must be scheduled within the channel. It can be disabled, so 
that it only plays if someone clicks a Hit Link, but it does need to be in the channel.
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Creating Text Fields

CoolSign Content Creator enables you to create text fields in your content. Text fields can 
contain either static text or be bound to a data table when creating dynamic content.

To create a text asset:

1. Select the text tool.

2. Click and drag in the media window to create the text asset.

To edit text field properties:

1. Select the Selection Tool.

2. Click the text asset in the media window or timeline to display the Text Properties 
window:

Name — The name of the text asset.
Text — The text string that is displayed in the text field. Click the ellipsis (...) button 
to open a multi-line text editor if you want to enter multiple lines of text.
Expression — You can enter a JavaScript expression to set the value of the text.
Font — You can set any TrueType or PostScript font that is currently installed on your 
system.
Style — You can toggle the style buttons to make your text bold, italicized, or under-
lined.
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Size — The maximum point size of the text. The actual point size might be smaller if 
Resize text to fit is checked.
Color — Specifies the fill color for the text.
Tracking — Sets the spacing between each character in the text. The tracking can 
range from -100 to 100.
Leading — Sets the spacing between each line in the text. The leading can range from 
-100 to 100.

Setting Text Layout Properties

You can define properties that determine how your text should be laid out within the text 
bounding box. This is especially useful when you are creating dynamic data fields where 
you don’t have control over exactly what text might be shown.

H-Align, V-Align — Specifies the horizontal and vertical alignment of the text within 
the bounding box. You can set both.
Trimming — Defines how the text box should wrap or crop text that is wider than the 
bounding box. When Wrap is checked, trimming defines where the text should break 
for the next line. If Wrap is not checked, trimming defines where the text should be 
cropped. Trimming has no visible effect when Wrap is off and Scale down text to fit is 
on.
Wrap — When checked, forces text to wrap to multiple lines if the text doesn’t fit on 
a single line. The Trimming and Resize text to fit properties determine how text is 
wrapped.
Resize text to fit — When checked, forces the text to fit within the bounding box by 
decreasing the font size if necessary. Text only resizes after accepting any trimming or 
wrap properties.
Boundary — Sets the width and height of the text field. You can also set these values 
by resizing the text field in the media window (“Using the Media Window Selection 
Tool” on page 21).
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Setting Drop Shadow Properties

You can set properties to add a soft drop shadow to text assets:

Show drop shadow — When checked, show a drop shadow on the selected asset.
Blur — How soft the drop shadow should be.
Opacity — The opacity of the drop shadow effect.
Color — The color of the drop shadow.
Offset — The offset (in pixels) of the drop shadow.

Setting Interactive Properties

Hit Link — If you are building interactive content, you can specify the name of the 
content to play when this video is clicked. To specify multiple pieces of content, sep-
arate the names with semicolons. To specify the region in which to play the content, 
include the @ sign. For an example of this usage, see “Creating Interactive Content” 
on page 27. 

IMPORTANT
The requested content must be scheduled within the channel. It can be disabled, so 
that it only plays if someone clicks a Hit Link, but it does need to be in the channel.
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Scrolling Your Content

The Content Creator provides a Scroll Tool that you can use to move other assets across the 
screen at a consistent speed. One common use of this tool would be to implement a scrolling 
ticker.

To create scrolling text:

1. Select the scroll tool.

2. Click and drag in the media window to define the dimensions of the scroll control. 
You can subsequently modify the dimensions in the Scroll Properties window.

3. Select the scroll control in the media window or timeline to display the Scroll 
Properties window:
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 41



. Advanced Content Creation 
Scrolling Your Content
Name — The name of the scroll control as it appears in the timeline and script.
Size — The dimensions (in pixels) of the scroll control.
Fill Color — The color that is used to fill the interior of the scroll control. To specify 
a transparent scroll control, select the Web tab (in the color selector) and click Trans-
parent.
Stroke Color — The color that is used to stroke the outline of the scroll control if the 
Stroke Width is greater than zero. To specify a transparent scroll control, select the 
Web tab (in the color selector) and click Transparent.
Stroke Width — Sets the width of the line that is used to stroke the outline of the scroll 
control. Setting the stroke width to zero removes the stroke.
Pick Scrolling Assets — Displays the Pick Scrolling Assets dialog. See “The request-
ed content must be scheduled within the channel. It can be disabled, so that it only 
plays if someone clicks a Hit Link, but it does need to be in the channel.” on page 43. 
for more details.
Horizontal Speed — The speed (in pixels per frame) with which all scrolling assets 
move across the screen horizontally. To scroll to the right, define a positive horizontal 
speed. To scroll to the left, make this a negative value.
Vertical Speed — The speed (in pixels per frame) with which all scrolling assets move 
across the screen vertically. To scroll down, define a positive vertical speed. To scroll 
up, make this a negative value.
To scroll diagonally (in multiple dimensions), define both a horizontal and vertical 
speed.
Horizontal Spacing — When scrolling multiple assets across the screen, this value 
sets the number of pixels that separate each asset horizontally.
Vertical Spacing — When scrolling multiple assets across the screen, this value sets 
the number of pixels that separate each asset vertically.
Only scroll one asset at a time — Check this box to limit the scroll control to a single 
asset at a time. The next asset does not appear on the screen until the current asset has 
completely exited the scroll control’s boundaries.
Repeat assets continuously (ticker mode) — Check this box to scroll assets contin-
uously, as with a stock ticker. The ticker clones one set of the assets for each row in 
the data table.
End playback after scrolling last row — Check this box to cause the entire piece of 
content to end playback as soon as all rows in the data table have been displayed in the 
ticker and have finished scrolling off the end of the screen. In the AdPlayer, this causes 
the next item in the channel schedule to begin to play.
Hit Link — If you are building interactive content, you can specify the name of the 
content to play when this scrolling element is clicked. To specify multiple pieces of 
content, separate the names with semicolons. To specify the region in which to play 
the content, include the @ sign. For an example of this usage, see “Creating Interactive 
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Content” on page 27.

IMPORTANT
The requested content must be scheduled within the channel. It can be disabled, so 
that it only plays if someone clicks a Hit Link, but it does need to be in the channel.

To select scrolling assets:

1. Click the Pick Scrolling Assets button in the Scrolling section of the Scroll properties 
window.

2. In the Pick Scrolling Assets dialog, perform the following actions as required:

1.  To select an asset that you want to scroll, click to select the asset from the list of 
available assets (on the left), then click the > button.

2.  To select all available assets, click the >> button.

3.  To remove an asset from the list of scrolling assets, click to select it in the list on 
the right, then click the < button.

4.  To remove all assets from the scrolling list, click the << button.

5.  To reorder the assets in the list on the right, use the up and down arrow 
buttons.
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The following limitations apply to scrolling:

• Only text, shapes, and images (not videos) can be scrolled. Text and images can be 
static, or they can be dynamically retrieved from the data table.

• You cannot scroll another scroll control.
• You cannot scroll an asset that is already assigned to another scroll control in the same 

project. You must first remove an asset from its current scroll control before you can 
add it to a different scroll control.

• You cannot scroll an individual data field that is assigned to a data panel.

After exiting the scroll control, the scrolling asset remains visible. To hide an asset that has 
exited the scroll control, you might want to superimpose a black box, JPEG, or other image.

Playing Your Content Back

The playback controls at the top of the timeline window can be used to play, pause, frame 
advance, frame rewind, and jump to the beginning or end of the content. The loop button 
can be toggled for looping playback. The current time of the content is displayed in the time 
field.
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Playback Controls

Loop Playback Time Field

Time Slider

NOTE
You can hold down the frame advance or frame rewind button to advance or rewind the 
content at a speed of five frames per second.

To start playing your content:

• Click the Play button in the timeline window.

or

• Select the menu item Playback > Play.

To jump to a specific time in your content:

1. Click the time field to display the Go To Time dialog. Or, select PLAYBACK > GO TO 
TIME.

2. Enter the time to jump to.

3. Click OK.

To scrub to a specific time in your content:

• Click and drag the time slider to the desired time.
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Using the Timeline Window

The timeline window displays a list of all the assets in your content and enables you to 
adjust transform properties, set animation key frames, and write transform expressions.

NOTE
The timeline refers to the length of time over which the content is played, and not the time 
of day scheduled for playback. For information on scheduling, see Chapter 7 “About 
Scheduling” of the CoolSign Network Mangager User’s Guide.

Changing the Layer of Assets in Your Content

Each asset of your content is listed in the timeline window in the order from top to bottom. 
Assets at the top of the list appear in your content composite above the assets that are below 
them in the list.

To change an asset’s layer:

• From the timeline window, click and drag the asset name above or below the other 
assets in the timeline window.

To bring an asset to the front:

• Select LAYOUT > BRING TO FRONT.

To send an asset to the back:

• Select LAYOUT > SEND TO BACK.

Setting the Start and Stop Time of Assets

Each asset can be set with a start and stop time. Assets are not visible before and after their 
start and stop times.
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Start Time Field

Stop Time Field

Stop Time Handle

Asset Time Bar
Start Time
  Handle

To set the start or stop time of an asset, do one of the following:

• Click and drag on the left or right handle of the asset’s time bar to set the start or stop 
time.

• Edit the start or stop time in the timeline window.

About Transform Properties

Every asset has a set of transform properties that can be animated. To expand the asset’s 
transform properties, click the + button to the left of the asset’s name.

Click the 
asset’s 
expand/col-
lapse button 
(+) to view the 
transform 
properties.

Every asset has the following transform properties:

• PositionX — Horizontal position of the center of the asset relative to the center of the 
stage (in pixels).

• PositionY — Vertical position of the center of the asset relative to the center of the 
stage (in pixels).

• Rotation — Rotation of the asset in degrees.
• ScaleX — Percentage that the asset is scaled in the horizontal dimension.
• ScaleY — Percentage that the asset is scaled in the vertical dimension.
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• Opacity — Percentage of transparency applied to the asset, ranging from 0% 
(invisible) to 100% (fully visible).

For some asset types, additional transform properties are available:

• FillColor — Color used to fill the asset. Available for shape and text assets.
• StrokeColor — Color used to stroke the asset. Available for shape assets only.
• Volume — Volume of embedded audio track. Available for video and flash assets 

only.

Editing Transform Properties

You can numerically edit the value of a transform property if you know the exact value you 
want to set.

To numerically edit the transform properties of an asset:

1. Click the Expand/Collapse (+) button to expand the transform properties for the 
asset.

2. Click the Value of the transform property you want to edit.

3. Type a new value into the field.

4. Press Enter or click off the field.

Interactively Editing Transform Properties

You can interactively adjust an asset’s transform properties and immediately see the 
changes in the media window.

To interactively edit the transform properties of an asset using the mouse:

• To interactively adjust the value of a transform property, click and drag horizontally 
on the property name. Drag to the left to decrease the value and drag to the right to 
increase the value.

• You can also click and drag the asset within the media window.

To interactively edit the transform properties of an asset using the keyboard:

1. Select the transform property you want to edit in the timeline window.

2. Do one of the following to:
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• Increment or decrement the value by 1, press either the left or right arrow keys as 
appropriate.

• Increment or decrement the value by 10, hold down the CTRL key while pressing 
either the left or right arrow keys as appropriate.

Animating the Transform Properties of an Asset

You can animate the transform properties of your assets by setting keyframes. A keyframe 
establishes the value of the property at a specific point in time. If you define multiple 
keyframes, the keyframe interpolation mode determines how the value of the property is 
interpolated over time — that is, how the property is animated between two adjacent 
keyframes. For more about interpolation modes, see “About Keyframe Interpolation 
Modes” on page 51.

To create a new keyframe for a transform property:

1. In the timeline window, select the transform property for which you want to set a 
keyframe.

2. Set the value of the transform property to the value you want the keyframe to use.

3. Position the time slider to the time at which you want to create the keyframe.

4. Right-click on the property name or in the keyframe area and choose Add new 
keyframe.

Keyframe AreaKeyframes
Current
Value

Understanding Keyframe Auto-Creation

Once you have set a keyframe for a transform property, the property is now animated. If 
you change the value of an animated property, one of two things can occur:

• If the time slider is set to the same time as an existing keyframe, the value of that 
keyframe is updated to reflect the new transform property value.

• If no keyframes are defined for the current time of the content, a new keyframe is 
automatically created with the transform property value at the current time.
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Editing Keyframes

You can edit the value of an existing keyframe, move the keyframe in time, or delete 
keyframes.

To edit the value of an existing keyframe manually:

1. Set the time slider to the same time as the keyframe.

2. Enter the desired value into the transform property.

To edit the time of an existing keyframe:

• In the timeline window, click and drag the keyframe to the new time.

To edit the value and time of an existing keyframe numerically:

1. Do one of the following:
• Double-click on the keyframe.
• Right-click on the keyframe and choose EDIT KEYFRAME. The Edit Keyframe dialog 

appears:

2. Edit the keyframe time, value, or interpolation mode.
• To navigate through other keyframes without having to close the Edit keyframe di-

alog, use the right and left arrow buttons in the Edit keyframe dialog.
• To select multiple keyframes in the timeline window — for example, the start and 

end values of the specific transform property — hold down the Shift key while se-
lecting. You can then drag the selected values to the new location.

3. Click Close.

To delete a keyframe:

• In the timeline window, right-click on the keyframe and choose DELETE KEYFRAME.

To delete all keyframes for a transform property:

1. In the timeline window, right-click on the property name or in the keyframe area. 
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2. Then, choose CLEAR ALL KEYFRAMES.

About Keyframe Interpolation Modes

CoolSign Content Creator currently provides two types of keyframe interpolation modes 
that set how a property is animated between two keyframes:

Linear — (Default) The property changes linearly from one keyframe to the next.

Linear Keyframe Interpolation Hold Keyframe Interpolation

Hold — The property holds at the first keyframe and immediately pops to the second 
keyframe value.

To edit the keyframe interpolation mode:

1. Do one of the following:
• Double-click on the keyframe.
• Right-click on the keyframe and choose EDIT KEYFRAME.

2. Select a new interpolation mode.

3. Click Close.

Setting Post-Interpolation Modes

By default, when you set keyframes for a property of an asset, the value of the last keyframe 
is held throughout the remainder of the content. There are a number of alternative post-
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interpolation modes that you can set to define how animation is interpolated after the last 
keyframe. The following post-interpolation modes are available:

Hold (Default) — The value of the last keyframe is held constant.

Extend — Extrapolate the slope between the last two keyframes so that the value con-
tinues at the same rate.

Mirror — Loop back and forth through all the set keyframes.

Cycle — Loop forward through all the set keyframes from the beginning.

Using Templates

Creating a template

Templates are a new feature in CoolSign. Consequently, you will need to create a new 
project to specify that it is a template. 

Templates can only be created using the CoolSign Content Creator. A template is basically 
a standardized layout that can be modified in only a specified manner. In CoolSign Content 
Creator, the Content Designer uses a data table and data table elements to specify what can 
be modified. Once the template has been created, the Content Designer publishes it to the 
CoolSign Content Creator and it is available for use in the web-based interface under the 
Templates tab.
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To create a template:

1. Create a new project, and select TEMPLATE for the Project Type.

2. Fill out the remaining project settings as you would normally.

3. When the project workspace opens, create the content that you want. See “Importing 
Assets into Content Creator” on page 24.
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4. Next, create a data table with data fields for the content elements that you want to be 
able to edit in the template. See “Using Data Tables” on page 55 and “Using Dynamic 
Data in Your Content” on page 69 information on this.

IMPORTANT
If you imported Photoshop asset that included layered elements that you want to 
replace with a dynamic data field so that it is editable, you will need to locate the layer 
element in the Timeline window, click the + to open the element’s properties and set 
the Opacity to 0%.

5. The data fields are bound with expressions to the data table. Refer to “Writing 
Content Creator Expressions” on page 79 for more information.

6. When finished, click FILE > PUBLISH TO NETWORK...

7. When prompted, click OK.

8. The CNM login screen appears, log in so that the content can be published.
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 54



. Advanced Content Creation 
Using Data Tables
9. When the files have been transferred, you can click the Templates tab in the web-
based user interface (WUI) to verify that your template is available.

Using Data Tables

One of most powerful features in CoolSign is the ability to have your content dynamically 
display information pulled from CoolSign data tables. The CoolSign Content Creator 
includes specific tools for integrating your content with dynamic data. You can use 
dynamic data features to create content that displays product pricing, weather reports, stock 
quotes, sports scores and more. Data from a CoolSign data table can be displayed in a text 
field or you can display images or movies imported into a data table. You can also write 
expressions that drive the properties of an asset based on dynamic information — for 
example, setting the height of a thermometer graphic in a weather ad or changing the color 
of text based on the data displayed.

Understanding Data Tables

In CoolSign, dynamic data is stored in data tables. Data tables can store text, numbers, 
dates, and media files like images and video. Content Creator lets you define your own data 
table structure, or you can import a data table from CNM. Once your data table structure is 
defined, you can enter sample data into the data table so you can preview what your content 
will look like.

NOTE
When you subsequently import the content into CNM, only the structure of the data table 
is imported; none of your sample data is filled in. You must use CNM to populate the data 
tables with the actual data.

Understanding Data Fields

In order to show dynamic data in your content, you need to create data fields for the data to 
be displayed in. Data fields are bound to the data in a CoolSign data table with binding 
expressions. Binding expressions are automatically generated when you create a data field, 
but they can be edited or created from scratch for more complicated bindings. A data field 
can either directly display the text from a data table or it can display an image or other 
media asset that the data table contains.

Using the Data Tables Window

The Data Tables window enables you to manage the data tables in your content. You can 
add a new empty data table to your project with no fields or sample data. You can then 
define fields and add sample data. When you import your content into a CoolSign network, 
the data table is automatically created and bound for you. For more details, see:
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• Create a data table (page 55)
• Edit data table properties (page 64)
• Enter sample data into your data table so you can preview how your content looks 

when played back (page 66)

Creating a Data Table

To add a new data table to your project:

1. In the Data Tables window, click New...

The Data Table dialog opens.
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 56



. Advanced Content Creation 
Using Data Tables
2. Enter a name for the new data table.

3. To add a field to the new data table, click Add.

The Field Properties dialog appears:
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Select the type of field.

Set the default value for new rows.

Set constraints on how data can 
be entered into the field.

Enter the name for the field.

4. Enter the name of the new field in the Field Name text box.

5. In the Field Type combobox, select the type to restrict entry to the field. You can 
choose one of the following field types:

NOTE
See “About Character Masking” on page 63. for a list of metacharacters, special 
characters, and literal characters that can be used when restricting field entries.

Text — Enables any alphanumeric characters, including the letters A-Z (upper and lower 
case) and number 0-9. Used for basic or European text.

Number — Enables numeric entry using a spin edit control.

Boolean — Enables boolean entry of True/False.

Date & Time — Enables both date and time entry.

Date — Enables date entry using a date/time picker control.

Time — Enables time entry using a time control.

Media — Enables import of an image, movie, or flash media asset.

Long Text — Enables memo-style text entry for long fields.
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International Text — Enables text that is not European. This refers to UTF-8 support (8-
bit UCS/ Unicode Transformation Format). UTF-8 is a variable-length character encoding 
for Unicode. It is able to represent any character in the Unicode standard, yet is backwards 
compatible with ASCII.

6. In the Default Value text box, enter the default value to use when a new row is added 
to the data table.

7. Set any desired constraints on what can be entered into the data field:
Use Picklist (Text only) — Displays the text field using a combobox where you can 
select from a list of pre-defined values. You can enter one or more pre-defined values 
in the picklist text box separated by carriage returns.
Allow Editing (Text only) — Enables you to enter custom values in addition to the 
values available from the picklist option.
Limit Chars (Text only) — Limits the maximum number of characters that can be 
typed into a text field.
Char Mask (Text only) — Restricts which characters can be entered into a text field.
Examples:

1.  A mask for entering a telephone number: (000)000-0000. 

Each zero (0) metacharacter in this mask requires a numeric character in the 
corresponding position. No characters can be omitted. Note that the “-”, 
“(and)” characters in the mask are literals.
Following are images of an editor that uses this mask:

(___) ___-____ (a value is not entered)

(a value is entered)(503) 555-1234

2.  A mask for entering a telephone number with an optional area code: (999)000-
0000.

The “9” metacharacter enables you to omit the area code part of a phone num-
ber.

(a valid phone number
without an area code part)

(___) 555-1234

3.  A mask for entering an alpha-numeric sequence: \A>LL-00.

The “\A” stands for the literal character “A”. Since “A” is used as a metacha-
racter, the backslash must be used to make “A” appear as a literal. The “>” 
command specifies that the following text should be in uppercase. The “LL” 
substring indicates that two alphabetical characters should be inserted in this 
position. The “00” substring is a placeholder for two digits.
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(a value is not entered)A__-__

(a value is entered)ASD-88

Force Case (Text only) — Forces the case of all characters to either upper or lower 
case.
Only allow values from (Number only) — Enables setting the minimum and maxi-
mum value of a number field.
Media Type (Media only) — Sets the type of media that can be imported into a media 
field.

Image Constraint (Media only) — When checked, importing images display a special 
dialog that can be used to crop and scale the imported image to fit the defined resolu-
tion.
When checked, causes a dialog to appear when you import an image, giving you the 
opportunity to crop and scale.
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8. Click OK.

9. To add another field, repeat steps 3. through 8.
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 61



. Advanced Content Creation 
Using Data Tables
10.When you’re done, click OK to close the Data Table Properties dialog. The Data 
Tables window now includes the fields that you’ve just added.

You can now:

• Import a data table from a CoolSign network (page 64).
• Create a filter expression on your data table to limit the records to display (page 64).
• Set the sorting order in which data from the table is displayed (page 66).
• Populate the data table with sample data so that you can preview how your content 

looks like when actually playing (page 66).

To edit a data table structure:

1. In the Data Tables window, click Edit...

2. Add new fields or delete fields as desired.

NOTE
You can also modify existing data structure elements (such as the data table name and 
data fields).
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3. Click OK.

NOTE
For detailed information about the available properties and data table field settings, see 
“Creating Data Fields” on page 69.

About Character Masking

Metacharacters—used to represent a range of symbols. You can enter text only in the 
positions that correspond to metacharacters. When a metacharacter is found at a specific 
position in the mask you can enter any character from the related range in this position in 
the edit box. The following table lists the available metacharacters: 

Character Meaning 

L Requires an alphabetic character in this position. For the United States, this is A-
Z, a-z. 

l Permits only an alphabetic character in this position, but doesn't require it. 
A Requires an alphanumeric character in this position. For the United States, this is 

A-Z, a-z, 0-9. 
a Permits only an alphanumeric character in this position, but doesn't require it. 
C Requires an arbitrary character in this position. 
c Permits an arbitrary character in this position, but doesn't require it. 
0 Requires a numeric character in this position. 
9 Permits only a numeric character in this position, but doesn't require it. 
# Permits only a numeric character or a plus or minus sign in this position, but 

doesn't require it. 

Special Characters—used to control the case of the input string and to represent various 
delimiters and currency symbols. 

Character Meaning 

> If a > character appears in the mask, all the characters that follow it are in upper-
case until the end of the mask or until a < character is encountered. 

< If a < character appears in the mask, all the characters that follow it are in lower-
case until the end of the mask or until a > character is encountered. 

<> If these two characters appear together in a mask, no case checking is performed 
and the data is formatted with the case you use during data entry. 
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Literal Characters —A character that is neither a metacharacter nor a special character is 
called a literal. Literals are inserted automatically as is into the edit box in their positions 
defined by the mask. There is no need to enter literal characters, the cursor skips over them 
during editing. 

NOTE
Metacharacters and special characters can also appear as literal characters if they are 
preceded by a backslash (\). 

Importing a Data Table from a CoolSign Network

If the data table for which you are creating content already exists, you can import it from a 
CoolSign network instead of creating it from scratch. This is especially useful if the content 
you are creating is bound to a data table that is created by an external data source like the 
CoolSign DataFeed or DataWatcher. When you import a data table, its current data values 
are imported as sample data.

To import a data table from a CoolSign network:

1. In the Data Tables window, click Import...

2. If you haven’t yet connected to a network, the standard CNM login dialog appears.

3. Select the data table you want to import from the list of available data tables.

4. Click OK.

Filtering Your Dynamic Data

Often, you’ll want to filter which rows in a data table that appear in your content. You can 
create a filter expression on your data table to limit the records to display.

To display the Set filter dialog:

1. In the Data Tables window, select the Properties tab for your data table.

/ A / character is used to separate the months, days, and years in dates. If the char-
acter that separates the months, days, and years is different in the regional settings 
of the system that the application runs on, that character is used instead. 

: A : character is used to separate the hours, minutes, and seconds in time values. If 
the character that separates the hours, minutes, and seconds is different in the 
regional settings of the system that the application runs on, that character is used 
instead. 

$ A $ character is used to designate currency values. If the character that designates 
the currency values is different in the regional settings of the system that the appli-
cation runs on, that character is used instead. 
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2. Click the ellipses (...) button to open the Set filter dialog.

Field — Select the field from your data table that you want to use in your filter criteria.
Condition — Select the condition that you want to use to compare the selected field 
against the criteria.
Value — You can manually enter a value to compare a field against.
Attribute — If you want to filter against an attribute of the node on which the content 
is playing, you can either enter the attribute name into the Attribute text box or you can 
click Select attribute to connect to a CoolSign Network and choose an attribute that ex-
ists on that network. Filtering against an attribute is useful when you want to localize 
the dynamic data in your content.
Default Value — If you’ve selected to filter against an attribute, you can enter the val-
ue of the attribute for previewing within the Content Creator. When your content is 
played back on a CoolSign player, the filter uses the value of the attribute for that play-
er.
Edit filter script — By default, this dialog opens with a simple interface that enables 
you to define your filter criteria. For more advanced filter expressions, you can check 
this box to display a field into which you can directly type a JavaScript filter expres-
sion.
Clear Filter — Click this button to reset your filter to display all available rows.
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Sorting How Your Data Displays

From the Data Tables window, you can set the sorting order in which data from your data 
table appears. This is useful when you are displaying data using a table-like format or if 
your content is looping to show multiple rows of data. There are two special sort orders:

InOrder — No additional sorting is applied to the data.
Shuffle — Rows are sorted randomly each time the content plays.

To sort your data based on a specific column, click the column header (or select the column 
from the Sort by menu).

You can also click the Ascending or Descending radio button to determine the sort order.

Entering Sample Data Into Your Data Table

You might want to preview your content with sample data in the data table so you can see 
what it looks like when actually playing and to make sure that your design supports the 
different data that can be entered.

To add a new row to the sample data:

1. In the Data Tables window, click Add Row.
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2. Click in the column and row you want to edit.

3. Do one of the following:
• Type a new value.
• Use the column editor controls to edit the field value.  

 
For example, use the column editor controls to edit an image field. When you de-
fine a data table field (such as the quantity) you can add a field and set it to each 
field type, which might have a column editor associated with it. If you create a field 
date and time field and then add a value, you get a drop down menu column editor 
that shows you a calendar. Once you create a field you’ll see the column editor 
controls associated with that field.

To delete a row from the sample data:

1. Select the row you want to delete by clicking in any field.

2. Click Delete Row.
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Ordering Your Sample Data

Every data table has a special ordering index field that determines the order of a row within 
the data. By default, the ordering field is not visible.

To display the ordering field:

1. In the data table’s sample grid, right-click anywhere to display the popup menu.

2. Select Show Ordering to toggle the visibility of the ordering field.

Printing Sample Data

You can print your sample data or save it to PDF or graphic files. To do so, choose Print 
Data from the sample grid’s pop up menu.
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Using Dynamic Data in Your Content

You can use data from a data table in your content in either of two ways: data fields or 
property expressions.

Creating Data Fields

As described previously (page 55), a data field can either directly display the text from a 
data table or it can display an image or other media asset that the data table contains.

To add a data field to your content:

1. Select the data field tool from the toolbar.

2. Click and drag in the media window to lay out the position and size of the data field.
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3. If you have not already added a data table to your project, the Create DataTable dialog 
appears, prompting you to create a new data table or import an existing data table 
from an available CoolSign network (see “Using Templates” on page 52).

4. After creating a new data table, or if a data table already exists in your project, the 
New Data Field dialog appears:

5. Do one of the following:
• Select a field from the field list.
• Click New Field to create a new field in the data table.

6. Click OK. If the field you selected is a media field, a media data field is automatically 
created; otherwise, a text data field is created.

Viewing Sample Data in Your Data Fields

If you’ve entered sample data into your data table, that data is used to populate your data 
fields using whatever filter and sort properties you might have set. If there is no sample data 
in your data table, or if your filter expression does not return any data, the data field displays 
the name of the field it was bound to.

Editing Expressions

When you create a data field, a binding expression is automatically generated for you that 
links the data field to a value in a data table. You can edit the expression for a data field or 
add a new expression for a text field with the Edit Expression dialog.

To edit the expression for a data field or text field:

1. Select the data field or text field in the media window or timeline to display the asset’s 
properties window.

2. In the Properties window, click Edit expression...
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3. The Edit Expression dialog appears:

You can use the expression builder to lay out the text as it should appear in your data field, 
concatenate multiple fields together, and format date/time or number fields.

Expression builder — You can edit the expression builder to add additional text or 
special characters into your expression. For example, if you type an exclamation point 
after the bound field (indicated by the field name in angle brackets), then an exclama-
tion point is always added in the data field regardless of what is typed into the data ta-
ble.
Available fields — All the fields from your data table and any special system fields 
are listed here. You can drag a field from the list into the Expression builder to add it 
to your expression. You can use this functionality to display multiple fields within your 
data field. For example, you might have a FirstName and a LastName field that you 
want to display together in a single data field.
Show script editor — Check this box to edit the actual JavaScript used for the expres-
sion. You can enter more complicated expressions this way.
Reevaluate expression every X seconds — Specifies how often the expression should 
be re-evaluated and updated. Set to zero if you want the expression to only be evaluated 
once when the content starts playing. When you add an asset to a ticker, its expression 
evaluation frequency is set to “-1”, which means that the expression is evaluated once 
for each row of data in the ticker.
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Formatting Expression Results

You can define some special formatting settings for the value that is returned by your 
expression, including a default value for when no data exists and whether to force the data 
to upper- or lower-case.

If your data field or expression returns a number or date/time value, you might want to 
format how that value appears in the data field. The Content Creator provides a large set of 
pre-defined format types for numbers and date/time values or you can create your own 
custom formats.

To customize how the data in a field is formatted:

1. Right-click on the field in the Expression builder to display the popup menu.

2. Select Format field... to display the Set Formatting dialog:

Default value — Specifies the value to display when there is no data in the bound 
field. For example, you might want to show blank records with “--” or “NoData” in-
stead of just a blank field.
Force case — You can use the pull-down menu to force the case of the data in a field 
to all upper-case or all lower-case.
Format value as — Specifies how to format the value of the field. When you select a 
format type other than None, the data format styles are shown. You can either select a 
pre-defined format from the list or enter a custom format. For example, if you select 
DateTime, the following Date format styles appear:
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 72



. Advanced Content Creation 
Using Dynamic Data in Your Content
Using Data Panels

A data panel is a special grouping of data fields that can be used to aid when creating 
content that displays multiple rows of data in a table-like format. For example, if you are 
creating content that appears in multiple rows of data from a sports score data table, it 
would be very tedious to have to add a data field for each field and row you wanted to 
display. Data panels enables you to set up one panel of data fields and then specify how 
many duplicates should be created. You have total design freedom to lay out the fields in 
your data panel however you’d like. You can even animate the data fields in a data panel.

To add a data panel to your project:

NOTE
First, design the data panel that you’ll create. This simplifies the task of subsequently 
populating the data panel.

1. If you have not added a data table to your project, use the Create DataTable dialog to 
create a new data table or import an existing data table from an available CoolSign 
network (see “Using Templates” on page 52).

2. Select the data panel tool from the toolbar.

3. Click and drag in the media window to position and lay out the panel.

4. Indicate whether you are creating a new table or importing an existing table:
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5. If this is a new table, give it a name:

6. Verify that the data panel is selected in the media window.

7. Select the data field tool from the toolbar.

8. Click and drag inside the data panel in the media window to position the data field. 
You can subsequently resize or rearrange the data fields.

9. When you’ve finished positioning your new data field, the New Data Field dialog 
appears:

10.  Choose the data table that is bound to this data panel.

11.  Do one of the following:
• Select a field from the field list.
• Click New Field to create a new field in the data table.

12.  Click OK.

13.  To add another field to the data panel, repeat steps 6 through 12.Once you’ve added 
fields to your data panel, you can set the properties for the data panel:
• General data panel properties (page 75)
• Layout properties (page 75)
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• Data properties (page 75)

Editing Data Panel Properties

You can edit data panel properties from the DataPanel properties window:

Name — Specifies the name of the data panel.
Data Table — Specifies which data table is bound to the data panel.
Start Row Index — Sets the index of the row of data to display in the first row of the 
data panel.

Setting Data Panel Layout Properties

Once you’ve added fields to your data panel, you can use the data panel layout properties 
to create additional rows and columns of fields. Use the data panel option to display one or 
more data field values. Use the data layout properties to display more than one row. 
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NOTE
The only way to add a data field within the data panel is by creating the data field inside 
the data panel. Rows are top to bottom and columns are side by side.

Rows — How many rows of data panels to display.
Cols — How many columns of data panels to display.
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Spacing — How many pixels each row or column should be offset.
Flow Direction — How records should flow into the rows and columns of data panels.
Child Animation Offset — The number of seconds that is used to offset any animated 
data fields in each data panel. You can use the timing offset property to stagger the an-
imation of data fields so that each row animates one after another or overlapping.

You can only interact with the first row of a data panel in media window. When you 
transform the data panel by repositioning it or resizing it, all other data panel rows snap to 
match. If you add additional data fields to the data panel or remove fields, all other data 
panel rows synchronize to match.

Setting Data Properties

When your data table has more rows of data than you can display at once in your content, 
you can use the data properties to define what should happen. For example, you might have 
designed content to display a list of menu items for a restaurant, but you can only fit five 
items on the screen at a time. The data properties determine what to do if there are more 
than five menu items in the data table.

Show multiple sets of data — When checked, this data panel is enabled to show mul-
tiple sets of rows during a single iteration of the content. Otherwise, the data panel does 
not advance beyond the selected rows in the data table until the next time the content 
plays.
Set duration — How long to wait before the data panel displays the next set of rows 
in the data table. The duration also appears in the timeline for the data panel as a green 
timeline bar. You can also adjust the duration by interactively adjusting the data pan-
el’s timeline bar.
Max sets — The maximum number of times that your content can loop to display mul-
tiple sets of data. The data panel never shows more rows than exists in your data table, 
but you can define a maximum number of sets in case you don’t want to loop through 
all the rows in a data table.
Auto-fit duration — When checked, your content automatically adjusts its duration 
to fit the number of rows that appear. This is extremely useful when you don’t know 
beforehand how many rows of data are going to be in the data table, but want to ensure 
that your content plays as long as necessary to show all the rows.
Pad start, Pad end — When Auto-fit duration is checked, you can also add an addi-
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tional pad to total duration of the content in case you want to display the final data 
row(s) for a longer period.
Always start from first row — When this box is not checked, the content remembers 
the last row that appeared the last time the content played, and begins with the next row 
in the data table. When this box is checked, the display always begins with row one in 
the data table.
Wrap data — When this box is checked, if there are fewer rows in the data table than 
there are in the data panel, the remaining rows of the data panel begin again with row 
one of the data table. Otherwise, the data panel is truncated after the last row of the ta-
ble appears.

Adding Expressions to Transform Properties

In addition to setting binding expressions for data fields, CoolSign Content Creator also 
enables you to create expressions for the transform properties of any asset. You can use 
transform expressions to dynamically set any transform property including position, scale, 
rotation, transparency, or color. When an expression is set for a transform property, the 
return value of the expression determines the value of the property. Properties with expres-
sions cannot be modified interactively via the media window or timeline window value 
editor. For more information on writing expressions, see “Writing Content Creator Expres-
sions” on page 79.

To set an expression on a transform property:

1. Select the transform property of the asset you want to set an expression for.

2. Right-click and choose Edit Expression from the pop-up menu.

3. Enter the expression into the Edit Expression dialog.

4. Click OK.

To clear an expression from a transform property:

1. Select the transform property.

2. Right-click and choose Clear expression.
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Writing Content Creator Expressions

All expressions in CoolSign Content Creator are written in JavaScript. There are numerous 
books and websites with information on programming in JavaScript. CoolSign Content 
Creator only processes “safe” JavaScript commands, so expressions cannot create 
windows, access the filesystem, or perform any other unsafe functions. When you are 
writing either a binding or transform expression, your expression is treated as a function 
and must return a string value as its final action. You are free to add any necessary logic or 
processing to derive the value that your expression returns and you can even have multiple 
functions defined within your expression.

Special Content Creator Functions

The Content Creator defines a number of special functions to make accessing data from 
data tables simpler from a binding or transform expression. These functions exist in the 
content’s global expression. 

NOTE
While it is possible to edit the global expression, doing so might make the content 
unreadable to Content Creator so proceed at your own risk.
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The following special functions are defined:

• Function GetValue (field)
• Returns a string value from the data table for the given field of the data table. If the 

field name does not exist in the data table, the default value parameter is returned.
• Function GetValueAtRow (field, index)

• Returns a string value from the data table for the given field and row index of the 
data table. If the field name or row index does not exist in the data table, the default 
value parameter is returned.

• Function GetValueEx (field, index, timeOffset, emptyValue)

• Function GetValueByFiltered (fieldToReturn, fieldToCheck, valueToCheck)

• Returns a string value from the data table for the given field and row index of the 
data table. If the field name or row index does not exist in the data table, the default 
value parameter is returned.

• Function FormatDateValue (value, format, defaultValue)
• Returns a date field from the data table formatted using the format parameter.

• Function FormatNumberValue (value, format, defaultValue)
• Returns a number field from the data table formatted using the format parameter.

• Function GetAttributeValue (attribute, defaultValue)
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• Returns the value of the attribute for the player on which the content is currently 
playing. If the attribute does not exist, the default value is returned.
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Publishing Content to a CoolSign Network

To publish content from CoolSign Content Creator to the CoolSign network, select the 
menu item FILE > PUBLISH TO NETWORK. If you haven’t already saved the project locally, 
you’ll be prompted to do so before you can publish the project.

To publish content from the Content Creator, you must have Write Content capability. For 
details, see the “About Security” section of the CoolSign Network Mangager User’s Guide.

When the CNM login dialog appears, enter your username and password and select the 
CoolSign network where you wish to import the content. 

IMPORTANT
If the content already exists on the network, it is overwritten.

After verifying your login credentials, the Content Creator publishes the content to the 
CoolSign network, then disconnects you from the CoolSign network.
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The CoolSign Content Wizard guides you through a series of steps to convert your digital 
media assets into content that can be played back on a CoolSign Digital Media Network. 
At any point, you can click the Prev button to return to previous steps.

Starting the CoolSign Content Wizard

To start the CoolSign Content Wizard: 

1. Browse to the CoolSign directory and open the Content Wizard folder.

2. Double-click the ContentWizard.exe to open the tool.

Converting Content

Step 1: Choose Asset(s) to Convert

Determine the media assets that you want to create into CoolSign content. You can convert 
a single asset into CoolSign content,configure video capture, or batch convert multiple 
assets.
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 83



A. Using the CoolSign Content Wizard 
Converting Content
To convert a single asset into CoolSign content:

1. Select the CONVERT SINGLE ASSET radio button.

2. Click Browse to locate the asset file you wish to convert. 
If you are converting a Flash asset that needs to load external files (such as images) at 
run time, make sure that the external files are in the same folder as your Flash asset, or 
in one of its subfolders. For example:
ContentFolder\ (root folder) 

ContentFolder\myFlash.swf (the asset that you’re converting) 
ContentFolder\Image\background.jpg 
ContentFolder\Image\banner.jpg

3. Click Finish to complete the content creation process. 
The Content Wizard prompts you as to whether or not you want to include all files in 
the ContentFolder folder and its subfolders (in this example, background.jpg and 
banner.jpg). After you confirm your choice, the two image files are packaged with 
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the Flash asset, resulting in a single piece of CoolSign content.

NOTE

Do not include any unrelated files in the folder that contains your Flash assets. If the 
content folder (or any of its subfolders) contains any unrelated files, they are included 
into your content and eventually imported to the network as well.

NOTE

For this reason, avoid importing Flash content from the desktop. Attempting to do so 
causes the entire contents of your desktop to be imported as well.

To configure video capture:

1. Select the CONFIGURE VIDEO CAPTURE radio button.

2. Click Browse to locate the asset file you wish to convert. 

3. Need to step through process.

To batch convert multiple assets into CoolSign content:

1. Select the Batch convert multiple assets radio button.

NOTE

If you select this button, you cannot include external files for a Flash asset, as 
described above.

2. Do one of the following:
• Click Add All Assets in Folder to recursively add all the assets located in a spe-

cific folder and subfolders to the batch list.
• Click Add Asset to add a single asset to the batch list.
• Click Remove Asset to remove a selected asset from the batch list.

3. When you’ve added all the assets you want to batch convert, click Next to proceed to 
the Set Options step.
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Step 2: Set Options

In this step, you can set properties regarding your content and preview how your content 
looks on different types of displays.

Setting Content Properties

You can set the following properties for your content:

Name—Set the name of this content as you wish it to appear in the CoolSign Network 
Manager. The default name is the name of the imported asset.

NOTE
With multi-file Flash assets, be sure to specify a legal folder name, so that multi-file Flash 
content will work properly.

Format—The format is automatically set based on the aspect ratio of the imported asset. 
You can change the format if the auto-detected value is incorrect. Once imported into 
CoolSign Manager, you can only schedule this content into channels with the same format.

Use Legacy Flash Player (enabled only for assets that are Flash 4 or earlier)—When 
checked, provides backward compatibility for SWF files that are Flash 4 or earlier.

Duration—You can adjust the length of time for which the content plays. If the content 
includes video or Flash assets, setting the duration to less than that of the video cuts off the 
video playing. Setting the duration to longer than that of the video asset causes the video to 
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hold on the last frame for the remainder of the content play. If the Set Duration to Asset 
Duration box is checked, the Duration field is greyed out.

Set Duration to Asset Duration—This checkbox is enabled only when digital video or 
Flash assets are being converted. Checking this box automatically sets the duration of the 
content to match the duration of the imported asset.

If the duration is set to within 0.1 of a second, it is rounded off to a the nearest second. For 
example, if the duration is any value between 9.90 and 10.1, it is rounded to 10 seconds. 
This is done to avoid unexpectedly strange values in the duration field.

Volume Gain—You can use volume gain to modify the overall volume level of all video, 
flash, or sound assets used in the content. The value can be between -100 and 100, with 0 
being the normal, unmodified volume level of the assets. You can use volume gain to 
normalize the volume of your content in relation to each other so that no one content item 
is softer or louder than the others.

Transition—You can set a transition effect and duration that is used to transition into the 
CoolSign content when played back.

Setting Asset Properties

Resolution—The horizontal and vertical resolution of your content in pixels.

Pre-rotation—Rotation of the asset in degrees.

Show Transparency (enabled only for Flash assets)—When checked, whatever areas of 
the Flash file were designated to be transparent are rendered with a transparent background. 
Checking this box has no visible effect if the Flash file contains no transparency.

Timeless (enabled only for Flash assets)—When set, CoolSign Player ignores the Flash 
asset's timeline.

Setting Content Resize Settings

Use these settings to define how the content should be displayed on players that are of 
different resolution than the selected content. The preview window automatically updates 
to reflect the content resize settings so you can dynamically preview the options. The 
following options are available:

• Scale Content To Fit—Scales content to fit the resolution of the player the content is 
scheduled on. If the aspect ratio of the player does not match the content’s aspect ratio, 
the content is stretched non-linearly to fill the player unless Preserve Aspect Ratio is 
checked.

• Preserve Aspect Ratio—Forces scaled content to preserve its original aspect ratio 
when played on players with different resolutions and aspect ratios than the content’s. 
The behavior of this checkbox is further defined by the following radio buttons:
• Crop edges of content—When scaling to fit, the content is scaled linearly until the 

smaller of the content’s width or height matches the smaller of the player’s width 
or height. This can result in pixels being cropped off the edge of the player.
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• Letterbox content—When scaling to fit, the content is scaled linearly until the larg-
er of the content’s width or height fits into the player’s width or height. The empty 
area that remains is black.

Setting Content Activation and Expiration

Content can be set to activate and/or expire at a certain date and time.

• Content Activation—Restrict when content is available to start playing. Content can 
be scheduled at any time but if its activation date is set to something other than Now, 
it does not play until the current date and time is past the set date.

• Content Expiration—Automatically delete content after the specified date and time. 
Content that has expired is deleted from a CoolSign network, including any players it 
was scheduled on, and moved to the Content Recycle Bin. All schedule and play 
history is lost when the content expires.

Previewing Content

The Preview content window displays a preview of your content and how it looks on 
different display types. 

Access the Preview Content 
window from the Options 
drop-down menu.

You can select different pre-defined display types or define your own custom resolutions. 
You can adjust the content’s resize properties to make sure you have the correct settings to 
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ensure that your content looks correct across different display types. If you didn’t install 
Direct X, you cannot review content.

NOTE
The Display type and Resolution settings are used for previewing only. They do not affect 
your content settings in any way.

To select a display to preview your content on:

1. Click the OPTIONS menu to open the Preview Options popup menu.

2. Do one of the following:
• Select a pre-defined display type from the Display type pull-down menu. The ap-

propriate resolution is automatically set and the preview window is updated to re-
flect your choice.

• Enter custom x and y resolutions into the Resolution fields. The preview window 
is updated to reflect your values.

3. Use the transport buttons to control playback and looping of the content preview.
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Step 3: Select Thumbnail

In this step, you can select a thumbnail image for your asset.

NOTE
If you are batch-converting multiple assets, a thumbnail for each content is automatically 
selected from a frame a few seconds from the end of the asset.

To select a thumbnail image for your content:

1. Using the content preview transport buttons or the time slider, set the preview to the 
frame of the asset you would like to use as a thumbnail.

2. Click Set thumbnail to current frame and the selected thumbnail image appears in 
the Thumbnail area. 

-or- 
Click Browse to locate an image file that you wish to use as a thumbnail for this asset. 
The image must be in one of the following formats: JPEG (*.jpg), Windows Bitmap 
(*.bmp), or Portable Network Graphics (*.png).

3. Use the Options button to preview how the thumbnail will render on a variety of 
monitor types at various resolutions.
When you’re done, click Next.
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Step 4: Create

In this step, you set the destination folder where your converted CoolSign content should 
be saved, along with some other settings.

Copying or Moving Asset Files

By default, when your content is created, the Content Wizard creates a copy of your 
imported asset and leaves the original file intact. If you are batch-processing a large number 
of assets and the destination folder is on the same hard drive as the original files, you can 
select Move asset file to output folder to force the Wizard to move the original file instead 
of copying it. This makes the batch process much faster.

NOTE
You should always keep a separate backup of your original assets.

Selecting a Folder to Save Your Content In

Before you can finish converting your asset into CoolSign content, you must select a desti-
nation folder in which to save the converted content.

To do so, click Browse to select a desired folder.
CoolSign Content Creator User’s Guide, Version 5.1, Issue 01 91



A. Using the CoolSign Content Wizard 
Converting Content
Importing Content into a CoolSign Network

If you want the Content Wizard to import your content directly into the CoolSign network, 
check the Import created content into a CoolSign network box. Using the radio buttons, 
indicate the action to take if there is already content with the same name as the content you 
are importing.

NOTE
To import content directly from the Content Wizard, you must have Write Content 
capability. For details, see 21. "About Security" on page 322 in the CoolSign Network 
Mangager User’s Guide.

When the CoolSign Manager login dialog appears, enter your user name and password and 
select the CoolSign network where you wish to import the content.

After verifying your login credentials, the Content Wizard imports the content into the 
CoolSign network, then disconnects you from the CoolSign network.

Completing the Content Wizard

After completing each step in the wizard, click Finish to convert the selected asset(s) into 
CoolSign content. The wizard creates your content in the destination folder ready for 
import into a CoolSign network. For more information, see “Managing Content” on 
page 106 of the CoolSign Network Mangager User’s Guide.
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Haivision One (1) Year Limited Warranty 

Havision warrants its hardware products against defects in materials and workmanship under normal use 
for a period of ONE (1) YEAR from the date of equipment shipment (“Warranty Period”). If a hardware 
defect arises and a valid claim is received within the Warranty Period, at its option and to the extent 
permitted by law, Havision will either (1) repair the hardware defect at no charge, or (2) exchange the 
product with a product that is new or equivalent to new in performance and reliability and is at least func-
tionally equivalent to the original product. A replacement product or part assumes the remaining warranty 
of the original product or ninety (90) days from the date of replacement or repair, whichever is longer. 
When a product or part is exchanged, any replacement item becomes your property and the replaced item 
becomes Havision’s property. 

EXCLUSIONS AND LIMITATIONS

This Limited Warranty applies only to hardware products manufactured by or for Havision that can be 
identified by the “Havision” trademark, trade name, or logo affixed to them. The Limited Warranty does 
not apply to any non-Havision hardware products or any software, even if packaged or sold with Havision 
hardware. Manufacturers, suppliers, or publishers, other than Havision, may provide their own warranties 
to the end user purchaser, but Havision, in so far as permitted by law, provides their products “as is”. 

Havision does not warrant that the operation of the product will be uninterrupted or error-free. Havision 
does not guarantee that any error or other non-conformance can or will be corrected or that the product 
will operate in all environments and with all systems and equipment. Havision is not responsible for 
damage arising from failure to follow instructions relating to the product’s use. 

This warranty does not apply: 

(a) to cosmetic damage, including but not limited to scratches, dents and broken plastic on ports; 

(b) to damage caused by accident, abuse, misuse, flood, fire, earthquake or other external causes; 

(c) to damage caused by operating the product outside the permitted or intended uses described by 
Havision; 

(d) to a product or part that has been modified to alter functionality or capability without the written 
permission of Havision; or 

(e) if any Havision serial number has been removed or defaced.

TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND REMEDIES PROVIDED 
ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, REMEDIES AND 
CONDITIONS, WHETHER ORAL OR WRITTEN, STATUTORY, EXPRESS OR IMPLIED. AS 
PERMITTED BY APPLICABLE LAW, HAIVISION SPECIFICALLY DISCLAIMS ANY AND ALL 
STATUTORY OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, WARRAN-
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TIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND WARRANTIES 
AGAINST HIDDEN OR LATENT DEFECTS. IF HAIVISION CANNOT LAWFULLY DISCLAIM 
STATUTORY OR IMPLIED WARRANTIES THEN TO THE EXTENT PERMITTED BY LAW, ALL 
SUCH WARRANTIES SHALL BE LIMITED IN DURATION TO THE DURATION OF THIS 
EXPRESS WARRANTY AND TO REPAIR OR REPLACEMENT SERVICE AS DETERMINED BY 
HAIVISION IN ITS SOLE DISCRETION. No Havision reseller, agent, or employee is authorized to 
make any modification, extension, or addition to this warranty. If any term is held to be illegal or unen-
forceable, the legality or enforceability of the remaining terms shall not be affected or impaired.

EXCEPT AS PROVIDED IN THIS WARRANTY AND TO THE EXTENT PERMITTED BY LAW, 
HAIVISION IS NOT RESPONSIBLE FOR DIRECT, SPECIAL, INCIDENTAL OR CONSEQUEN-
TIAL DAMAGES RESULTING FROM ANY BREACH OF WARRANTY OR CONDITION, OR 
UNDER ANY OTHER LEGAL THEORY, INCLUDING BUT NOT LIMITED TO LOSS OF USE; 
LOSS OF REVENUE; LOSS OF ACTUAL OR ANTICIPATED PROFITS (INCLUDING LOSS OF 
PROFITS ON CONTRACTS); LOSS OF THE USE OF MONEY; LOSS OF ANTICIPATED 
SAVINGS; LOSS OF BUSINESS; LOSS OF OPPORTUNITY; LOSS OF GOODWILL; LOSS OF 
REPUTATION; LOSS OF, DAMAGE TO OR CORRUPTION OF DATA; OR ANY INDIRECT OR 
CONSEQUENTIAL LOSS OR DAMAGE HOWSOEVER CAUSED INCLUDING THE REPLACE-
MENT OF EQUIPMENT AND PROPERTY, ANY COSTS OF RECOVERING, PROGRAMMING, 
OR REPRODUCING ANY PROGRAM OR DATA STORED OR USED WITH HAIVISION 
PRODUCTS AND ANY FAILURE TO MAINTAIN THE CONFIDENTIALITY OF DATA STORED 
ON THE PRODUCT. THE FOREGOING LIMITATION SHALL NOT APPLY TO DEATH OR 
PERSONAL INJURY CLAIMS, OR ANY STATUTORY LIABILITY FOR INTENTIONAL AND 
GROSS NEGLIGENT ACTS AND/OR OMISSIONS. 

OBTAINING WARRANTY SERVICE

Before requesting warranty service, please refer to the documentation accompanying this hardware 
product and the Havision Support Portal http://support.haivision.com. If the product is still not func-
tioning properly after making use of these resources, please contact Havision or Authorized Reseller 
using the information provided in the documentation. When calling, Havision or Authorized Reseller will 
help determine whether your product requires service and, if it does, will inform you how Havision will 
provide it. You must assist in diagnosing issues with your product and follow Havision’s warranty 
processes. 

Havision may provide warranty service by providing a return material authorization (“RMA”) to allow 
you to return the product in accordance with instructions provided by Havision or Authorized Reseller. 
You are fully responsible for delivering the product to Havision as instructed, and Havision is responsible 
for returning the product if it is found to be defective. Your product or a replacement product will be 
returned to you configured as your product was when originally purchased, subject to applicable updates. 
Returned products which are found by Havision to be not defective, out-of-warranty or otherwise ineli-
gible for warranty service will be shipped back to you at your expense. All replaced products and parts, 
whether under warranty or not, become the property of Havision. Havision may require a completed pre-
authorized form as security for the retail price of the replacement product. If you fail to return the replaced 
product as instructed, Havision will invoice for the pre-authorized amount. 

APPLICABLE LAW

This Limited Warranty is governed by and construed under the laws of the Province of Quebec, Canada.

This Limited Hardware Warranty may be subject to Havision’s change at any time without prior notice.
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Haivision Software End-User License Agreement

READ BEFORE USING

THE SOFTWARE PROGRAMS ARE PROTECTED BY NATIONAL AND INTERNATIONAL 
COPYRIGHT LAWS AND TREATIES. READ THE TERMS OF THE FOLLOWING END USER (SOFT-
WARE) LICENSE AGREEMENT (“AGREEMENT”) CAREFULLY BEFORE USING THE PRODUCT. 
BY USING THE PRODUCT, YOU CONFIRM YOUR ACCEPTANCE OF THIS AGREEMENT. IF YOU 
DO NOT AGREE TO THESE TERMS, HAIVISION IS UNWILLING TO LICENSE THE LICENSED 
SOFTWARE TO YOU AND YOU ARE NOT AUTHORIZED TO INSTALL OR USE THE LICENSED 
SOFTWARES.

1. DEFINITIONS

1.1 Entitlement. The collective set of applicable documents authorized by Haivision Systems Inc. or its 
affiliate Haivision (collectively “Havision) evidencing your obligation to pay associated fees (if any) for the 
license, associated Services, and the authorized scope of use of Licensed Software under this Agreement.

1.2 You (or Your). The individual or legal entity specified in the Entitlement, or for evaluation 
purposes, the entity performing the evaluation.

1.3 License Fee. License Fee shall mean the consideration paid to Havision for use of the Licensed 
Software. The License Fee is part of the price paid for the relevant Product.

1.4 Licensed Software. Licensed Software shall mean the executable version of Havision’s computer 
software, program or code, in object code format (specifically excluding source code), together with any 
related material including, but not limited to the Reference Manuals or database schemas provided for use in 
connection with the Licensed Software and including, without limitation, all Upgrades through the date of 
installation.

1.5 Reference Manuals. Reference Manuals shall mean the most current version of the documentation 
for use in connection with the Licensed Software provided by Havision to You.

1.6 Updates. Updates shall mean any periodic software releases, additions, fixes, and enhancements 
thereto, release notes for the Licensed Software and related Reference Manuals, (other than those defined 
elsewhere in this section as Upgrades) which have no value apart from their operation as part of the Licensed 
Software and which add minor new functions to the Licensed Software, but none so significant as to warrant 
classification as an Upgrade, which may be provided by Havision to fix critical or non-critical problems in 
the Licensed Software on a scheduled, general release basis. Updates to the Licensed Software (“Version”) 
are denoted by number changes to the right of the decimal point for a version and revision number (for 
example going from 2.0.0 to 2.1.3).

1.7 Upgrades. Upgrades shall mean any modification to the Licensed Software made by Havision, 
which are so significant, in Havision’s sole discretion, as to warrant their exclusion under the current license 
grant for the Licensed Software. Upgrades of Licensed Software are denoted by number changes to the left 
of the decimal point for a release number (for example going from 2.0 to 3.0).

2. RIGHTS GRANTED, RESTRICTIONS AND SUPPORT

2.1 License to Use.
(a) Subject to the terms and conditions set forth herein and subject to the terms of your Enti-

tlement, Havision hereby grants to You a non-exclusive, personal, limited and nontransferable right and 
license to use the Licensed Software in accordance with the terms of this Agreement. This license is granted 
to You and not, by implication or otherwise, to any parent, subsidiary or affiliate of Yours without Havision’s 
specific prior written consent. This license is for the limited use of the Licensed Software by You for the 
purpose of creating, managing, distributing and viewing IP Video assets. This license does not grant to You 
the right to use any Licensed Software in connection with any public broadcasting or broadcasting for home 
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or residential purposes, or any license for content whatsoever. The license and rights granted to You in this 
Section (2.) do not include the right to sublicense to distributors, resellers and other third parties any of the 
rights granted to You in this Section (2.). All rights not expressly granted You in this Agreement are reserved 
to Havision and no implied license results from this license.

2.2 Restrictions.
(a) Reproduction. You shall not copy, distribute, reproduce, use or allow access to any of the 

Licensed Software, except as explicitly permitted under this Agreement. You shall not modify, adapt, trans-
late, export, prepare derivative works from, decompile, reverse engineer, disassemble or otherwise attempt to 
derive source code from the Licensed Software or any internal data files generated by the Licensed Software, 
or use the Licensed Software embedded in any third party hardware or software. You shall also not use the 
Licensed Software in an attempt to, or in conjunction with, any device, program or service designed to 
circumvent technological measures employed to control access to, or the rights in other work protected by 
copyright laws. You shall not remove, modify, replace or obscure Havision’s copyright and patent notices, 
trademarks or other proprietary rights notices affixed to or contained within any Licensed Software. No right 
is granted hereunder for any third party who obtains access to any Licensed Software through You to use the 
Licensed Software to perform services for third parties. 

(b) Ownership. The Licensed Software is conditionally licensed and not sold. As between the 
parties, Havision and/or its licensors owns and shall retain all right, title and interest in and to all of the 
Licensed Software, including all copyrights, patents, trade secret rights, trademarks and other intellectual 
property rights therein, and nothing in this Agreement shall be deemed to transfer to You any ownership or 
title to the Licensed Software. You agree that it will not remove, alter or otherwise obscure any proprietary 
rights notices appearing in the Licensed Software. All Havision technical data and computer software is 
commercial in nature and developed solely at private expense.

3. TERM AND TERMINATION

3.1 Term. The license and service term are set forth in your Entitlement(s). Additionally, this 
Agreement may be terminated without cause by You upon thirty (30) days written notice to Havision.

3.2 Termination for Breach. Your rights under this Agreement will terminate immediately without 
notice from Havision if You materially breach it or take any action in derogation of Havision’s rights to 
Software. Havision may terminate this Agreement should any Software become, or in Havision’s reasonable 
opinion likely to become, the subject of a claim of intellectual property infringement or trade secret 
misappropriation.

3.3 Termination; Effect; Survival. Upon the termination of this Agreement for any reason: (a) all 
license rights granted hereunder shall terminate; (b) You shall immediately pay to Havision all amounts due 
and outstanding as of the date of such termination or expiration; and (c) You shall return to Havision all 
Licensed Software and all Havision Confidential Information not otherwise required under the terms of this 
Agreement or certify that all such Licensed Software and Confidential Information have been destroyed. 
Notwithstanding any termination of this Agreement, the following provisions of this Agreement shall 
survive for the relevant period of time set forth therein, if any: Sections 2.2, 4.1, 4.2, and 6.
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4. REPRESENTATIONS, DISCLAIMER AND LIMITATION OF LIABILITY

4.1 Havision Warranty.

(a) Havision warrants that the Licensed Software will operate substantially in accordance with 
the Reference Manuals provided for a term of ninety (90) days (the “Warranty Period”) after its delivery date. 
As Your sole and exclusive remedy for any breach of this warranty, Havision will use its commercially 
reasonable efforts to correct any failure of the Licensed Software to operate substantially in accordance with 
the Reference Manuals which is not the result of any improper or unauthorized operation of the License 
Software and that is timely reported by You to Havision in writing within the Warranty Period, provided that 
in lieu of initiating commercially reasonable efforts to correct any such breach, Havision may, in its absolute 
discretion, either (i) replace the Licensed Software with other software or technology which substantially 
conforms to the Reference Manuals or (ii) refund to You a portion of the fee paid for the relevant Product, 
whereupon this Agreement shall terminate. This warranty shall immediately terminate if You or any third 
party makes or attempts to make any modification of any kind whatsoever to the Licensed Software.

(b) All proprietary Hardware, if any, will be subject to the then current warranty terms of 
Havision. All non-proprietary Hardware, if any, is sold “AS IS”; however, to the extent that Havision has the 
legal right to do so, Havision hereby transfers to You any and all warranties made by Havision's vendors to 
Havision with respect to such non-proprietary Hardware which was sold by Havision or the Reseller to You, 
provided that You expressly acknowledge and agree that Havision disclaims any and all liability in connec-
tion with any such non-proprietary Hardware, as set forth in Section 4.2(b) of this Agreement.

4.2 Warranty Disclaimers.

(a) THE EXPRESS WARRANTIES SET FORTH IN SECTION 4.1(a) ABOVE IN 
RESPECT OF THE LICENSED SOFTWARE ARE IN LIEU OF ALL OTHER WARRANTIES, 
WHETHER EXPRESS OR IMPLIED, OR STATUTORY, REGARDING THE LICENSED SOFTWARE, 
OR ITS OPERATION, FUNCTIONALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR PURPOSE, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABI-
LITY OR FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF THIRD PARTY 
RIGHTS (ALL OF WHICH ARE DISCLAIMED). HAIVISION DOES NOT WARRANT THAT ANY OF 
THE LICENSED SOFTWARE WILL MEET ALL OF YOUR NEEDS OR REQUIREMENTS, OR THAT 
THE USE OF ANY OF THE LICENSED SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, 
OR THAT ALL ERRORS WILL BE DETECTED OR CORRECTED.

(b) THE EXPRESS WARRANTIES SET FORTH IN HAIVISION’S WARRANTY TERMS 
IN RESPECT OF HAIVISION PROPRIETARY HARDWARE ARE IN LIEU OF ALL OTHER 
WARRANTIES, WHETHER EXPRESS OR IMPLIED, OR STATUTORY, REGARDING ANY SUCH 
PROPRIETARY HARDWARE, OR ITS OPERATION, FUNCTIONALITY, PERFORMANCE, 
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE, INCLUDING ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
ALL NON-PROPRIETARY HARDWARE SOLD BY HAIVISION OR THE RESELLER TO YOU IS 
SOLD “AS IS” EXCEPT FOR HAIVISION’S AGREEMENT TO TRANSFER TO YOU ANY 
WARRANTY GIVEN TO IT BY ANY VENDOR FROM WHOM SUCH HARDWARE WAS 
PURCHASED FOR RESALE TO YOU HEREUNDER IN ACCORDANCE WITH THE PROVISIONS OF 
SECTION 4.1(b), AND HAIVISION DISCLAIMS ALL OTHER WARRANTIES, WHETHER EXPRESS 
OR IMPLIED, OR STATUTORY, REGARDING ANY SUCH NON-PROPRIETARY HARDWARE, OR 
ITS OPERATION, FUNCTIONALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE.

4.3 Liability Limitation. IN NO EVENT SHALL HAIVISION OR ITS OFFICERS, EMPLOYEES, 
AGENTS, REPRESENTATIVES, MEMBERS OF HAIVISION, NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION OR DELIVERY OF THE LICENSED SOFTWARE, 
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BE LIABLE TO YOU, YOUR CUSTOMERS OR TO ANY OTHER THIRD PARTY FOR 
CONSEQUENTIAL, INDIRECT, INCIDENTAL OR SPECIAL DAMAGES, LOST PROFITS, LOSS OF 
USE, INTERRUPTION OF BUSINESS OR FOR ANY DAMAGES FOR ANY BREACH OF THE 
TERMS OF THIS AGREEMENT OR FOR LOST OR CORRUPTED DATA ARISING FROM ANY 
CLAIM OR ACTION HEREUNDER, BASED ON CONTRACT, TORT OR OTHER LEGAL THEORY 
AND WHETHER OR NOT SUCH PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. HAIVISION SHALL NOT BE LIABLE FOR DAMAGES FOR ANY CAUSE 
WHATSOEVER IN AN AMOUNT IN EXCESS OF THE FEE PAID TO HAIVISION BY YOU FOR THE 
RELEVANT PRODUCT.

5. INDEMNIFICATION

5.1 Indemnification by Havision.
(a) Havision shall indemnify and hold You harmless against any and all actions, claims, losses, 

damages, liabilities, awards, costs and expenses (including reasonable attorneys’ fees) (“Claims”) arising out 
of i) any accusation or purported violation of any third person’s US and copyright, trademark, patent rights 
or trade secrets, proprietary information on account of Your use of the Licensed Software when used in accor-
dance with the terms of this Agreement, or (ii) relating to or arising out of any negligence or wilful miscon-
duct on the part of Havision or any breach by Havision of the terms of this Agreement or any Maintenance 
and Support Agreement, or applicable law. You shall promptly notify Havision in writing of any such Claim 
and promptly tender the control of the defense and settlement of any such Claim to Havision. Havision shall 
thereafter undertake the defense of any such Claim using counsel of its choice. You shall cooperate with 
Havision, in defending or settling such Claim at the expense of Havision; provided that Havision shall not 
settle any Claim against You which would require the payment of money by You without the prior written 
consent of You, which consent shall not be unreasonably withheld. You shall have the right to consult and 
provide input into the defense with counsel of its choice at its own expense. Havision shall not reimburse You 
for any expenses incurred by You without the prior written approval of Havision, which approval shall not 
be unreasonably withheld.

(b) If any Licensed Software is, or in the opinion of Havision may become, the subject of any 
Claim for infringement, then Havision may, or if it is adjudicatively determined that any of the Licensed 
Software infringes in the manner described above (except to the extent that any translation, modification, 
addition or deletion or combination by You is the sole source of such Claim), then Havision shall, at its option, 
either (i) procure for You the right to continue use of the Licensed Software for the term hereof, (ii) replace 
or modify the Licensed Software with other suitable and reasonably equivalent products so that the Licensed 
Software becomes non-infringing, or (iii) terminate this Agreement and refund to You a portion of the fee 
paid for the relevant Product.

(c) Havision shall have no liability for: (i) the use of other than the then current release of the 
Licensed Software; (ii) the use of the Licensed Software other than as set forth in its accompanying documen-
tation and as permitted herein; (iii) the modification of any of the Licensed Software by any party other than 
Havision; or (iv) any infringement arising from the use of any Licensed Software by You after Havision has 
issued a written notice to You requiring You to cease using such Licensed Software when Havision exercises 
its option to terminate the License pursuant to Section 3.2 (collectively, “Exclusions”). SECTION 5.1 
STATES HAIVISION’S ENTIRE OBLIGATION WITH RESPECT TO ANY CLAIM REGARDING THE 
INTELLECTUAL PROPERTY RIGHTS OF ANY THIRD PARTY.

5.2 Indemnification by You. You shall indemnify and hold Havision harmless against any and all 
Claims directly or indirectly arising out of, or in any manner whatsoever associated or connected with Your 
performance, purported performance or non-performance of its rights and obligations under this Agreement, 
and against any and all Claims incurred by or on behalf of any of the foregoing in the investigation or 
defense of any and all such Claims.
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6. OTHER PROVISIONS

6.1 Export and Other Restrictions. This Agreement, and all Your rights and Your obligations under this 
Agreement, are subject to all applicable Canadian and U.S. Government laws and regulations relating to 
exports including, but not limited to, the U.S. Department of Commerce Export Administration Regulations 
and all administrative acts of the U.S. Government thereunder. In the event the Licensed Software or the 
Hardware is exported from the United States or re-exported from a foreign destination, You shall ensure that 
the distribution and export/re-export of the Licensed Software or the Hardware is in compliance with all 
laws, regulations, orders, or other restrictions of the U.S. Export Administration Regulations. You agree that 
neither it nor any of its Affiliates will export/re-export any Licensed Software, Hardware, technical data, 
process, Products, or service, directly or indirectly, to any country for which the Canadian government or 
United States government (or any agency thereof) requires an export license, other governmental approval, 
or letter of assurance, without first obtaining such license, approval or letter.

6.2 Publicity. Neither party shall make or authorize or permit any other person to make any 
announcement or other like statement concerning this Agreement or the subject matter, terms or conditions 
hereof, without the other party’s prior written consent.

6.3 Transfer and Assignment. Havision may assign, sublicense, or transfer this Agreement and/or any 
or all of its rights or obligations hereunder. You may not assign, transfer or delegate any of its rights or 
obligations hereunder (whether by operation of law or otherwise) without the prior written consent of 
Havision. Any unauthorized assignment, transfer or delegation by You shall be null and void. No other 
Person shall have or acquire any right under or by virtue of this Agreement.

6.4 Waiver and Amendment. No modification, amendment or waiver of any provision of this 
Agreement shall be effective. No failure or delay by either party in exercising any right, power or remedy 
under this Agreement, except as specifically provided herein, shall operate as a waiver of any such right, 
power or remedy. Without limiting the foregoing, any terms and conditions of the Entitlement or similar 
materials submitted by either party to the other shall be of no force or effect.

6.5 Enforcement by Third Party. For any Licensed Software licensed by Havision from other suppliers, 
the applicable supplier is a third party beneficiary of this Agreement with the right to enforce directly the 
obligations set forth in this Agreement against You.

6.6 Governing Law. This Agreement shall be governed by and construed in accordance with the laws 
of the Province of Québec, Canada and the Laws of Canada applicable therein (excluding any conflict of 
laws rule or principle, foreign or domestic).

6.7 Severability. If any provision of this Agreement is held by a court of competent jurisdiction to be 
contrary to law, such provision shall be changed and interpreted so as to best accomplish the objectives of 
the original provision to the fullest extent allowed by law and the remaining provisions of this Agreement 
shall remain in full force and effect.

6.8 Force Majeure. Neither party shall be liable to the other party for any failure or delay in 
performance to the extent that such delay or failure is caused by fire, flood, explosion, war, terrorism, 
embargo, government requirement, labor problems, export controls, failure of utilities, civil or military 
authority, act of God, act or omission of carriers or other similar causes beyond its control. If any such event 
of force majeure occurs, the party delayed or unable to perform shall give immediate notice to the other 
party, and the party affected by the other's delay or inability to perform may elect, at its sole discretion, to 
terminate this Agreement or resume performance once the condition ceases, with an option in the affected 
party to extend the period of this Agreement up to the length of time the condition endured. Unless written 
notice is given within 30 calendar days after the affected party is notified of the condition, the latter option 
shall be deemed selected. During an event of force majeure, the affected party shall exercise reasonable 
effort to mitigate the effect of the event of force majeure.

If you have questions, please contact Haivision Systems Inc., 4445 Garand, Montréal, Québec, H4R 2H9 
Canada.
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